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A. Why has the Washington State Department of Transportation (WSDOT) implemented DMCS powered by
B2GNow?

This system enhances WSDOT’s commitment to inclusion and allows for thorough and accurate monitoring and
reporting of prompt payment by WSDOT’s contractors and consultants.

As a requirement of receiving federal-aid, per 49 Code of Federal Regulation Part 26, WSDOT implements the
Disadvantaged Business Enterprise (DBE) Program which requires the agency to monitor prompt payment to all
subcontractors on federal-aid projects and to improve our state funded diversity reporting and prompt payment
monitoring.

B. After reading this manual, you should be able to do the following:

e Find and access the Diversity and Management Compliance System powered by B2GNOW
e How to set up your dashboard

e How to access/monitor contracts

e How/what to review on contracts and subcontractors

For any questions you might have outside of this particular module/topics, we ask that you email or call 360.705.7045

Americans with Disabilities Act (ADA) Information: This material can be made available in an alternate format by emailing the Office of Equal Opportunity at wsdotada@wsdot.wa.gov or by
calling toll free, 855-362-4ADA(4232). Persons who are deaf or hard of hearing may make a request by calling the Washington State Relay at 711.

Title VI Notice to Public: It is the Washington State Department of Transportation’s (WSDOT) policy to assure that no person shall, on the grounds of race, color, national origin or sex, as
provided by Title VI of the Civil Rights Act of 1964, be excluded from participation in, be denied the benefits of, or be otherwise discriminated against under any of its federally funded
programs and activities. Any person who believes his/her Title VI protection has been violated, may file a complaint with WSDOT’s Office of Equal Opportunity (OEO). For additional
information regarding Title VI complaint procedures and/or information regarding our non-discrimination obligations, please contact OEQ’s Title VI Coordinator at (360) 705-7090.
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Information for WSDOT
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Contact Us & Support

We appreciate your feedback and are here to assist you. Please choose one of the following links to get you to the right team.

WSDOT System Contacts:

P DiversityReporting@wsdotwa.gov
‘OMWBE Customer Service:
Omwbeadmin@omwbe.wa.gov
360) 664-9750 or
Toll Free (866) 208-1064
System Support:

Technical Support

Need help?

Some questions may be answered by watching a tutorial video:

* Account Lookup * New User Request &)

* Forgot Password & * Request Username and Password

* Change User Information /5
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Logging into DMCS
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FORGOT USERNAME / ACCOUNT LOQKUP

Password

FORGOT PASSWORD

[J Remember Username

System Access Login
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Click on the word ‘View’ to open the following menu:

7 WSDOT

& = 9 5

Home

View >

Search »
Reporting >
Create

Tools »

Settings »

Help & Support »
Logoff

Show All Hide All

The System Dashboard

Welcome to your new Dashboard!

This tool can be personalized and configured to display
exactly the information you want to see, in a simpler &
cleaner format.

Take advantage of many powerful features:

0

.

-

.

-

0

Control exactly what, where, and how to display
data

Add multiple blocks of information

Flace a block on the left or right of the
Dashboard

Set data based on your own assigned records or
the entire organization

Move blocks up or down on the Dashboard
Change the color of a block to highlight important
information

MNew data options are added maonthly

Click Personalize to get started.

Refresh  Personalize ({3)

Alerts
o Activated Alerts. View Pending Alerts,

Config

System News

NEW FEATURE -- "Saved Search
Parameters"

A little bit of development magic to report -- you can
now save search parameters for future use. Run any
kind of search (wvendor, certified vendor, contract, ete.)
and at the bottom of the results page click the Save
Search Parameters button, enter a2 descriptive
refarence name, and save. Every time you revisit the
search page, there will be 2 Used Saved Search
button at the top that will list all saved searches
available to you. #WishListDreamsDoComeTrua!

Note: this feature does not save the search results, it
saves the search parameters. So using the saved
sesrch in the fufure will rerun the search parameters
with then-current data. It saves the time of having to
manually enter multiple parameters for complax
searches.

Final Call - 2018 User Training - May
21-24

Click here for class list, agenda, more details,
and registration

Have you seen the Wish List module? Check it out
here to submit ideas for system enhancements, vote on
others' suggestions, and join the discussion by adding
comments. We welcome your feedback to build a better
system.

Recent Enhancements - Click View Mew System News
belaw for details.

) View New System News
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» WSDOT

& =3 B &

Home

View »
Alerts

The gystem Dashboard

Welcome to your new Dashboard!

This tool can be personalized and configured to display exactly the information you want to see, in a

simpler & cleaner format.

Take advantage of many powerful features:

v

Contracts

Contract Audits

Sub Requests

1391 Reports
Outreach Campaigns
Events

Vendor Lists

Proposals
Utilization Plans

Support
Messages

Search »
Reporting »
Create »

Tools »

Settings »

Help & Support »
Logoff

Show All

Hide All

Control exactly what, where, and how to display data

Add multiple blocks of information

Place a block on the left or right of the Dashboard
Set data based on your own assigned records or the entire organization

MMove blocks up or down on the Dashboard

Change the color of a block to highlight important information

New data options are added monthly

Click Personalize to get started.

#WSDOT

View »

Alerts
Contracts
Contract Audits
Sub Requests
Qutreach Campaigns
Events

Vendor Lists
Proposals
Utilization Plans
Support
Messages

3
o>
Create »

Tools »

[pettings »

Help & Support »
Logoff

Show All

Hide All

Transactions: Contracts

Commm| Contract Audits | Sub Reguests | Proposals | UﬂPlans| Outreach ‘ Support ‘ Messages

o= @ &b Show ONLY contracts assigned to you

1 - 11 of 11 records displayed: Previous Page < Page | 1 > Next Page Records per page | 20
To resort, click on column title. Aefresh Table
Actions Alert Status  Secondary Status Contract Number Description End Date ¥ Amount
Al Open Al Al Al
Viev: End within 12 Open Locked In 003098 Test Prime Vendor 24 5/22/17 - 6/30/18
mo. PLAYGROUND. US 37/5R 14, PAVING - $4,600,520
KLICKITAT COUNTY
View End within 12 Cpen Locked In 003130 Quigg Brothers Inc. 8/10/17 - 9/30/16
mo. SR 105, NORTH COVE VICINITY EROSION $2,352,181
PROTECTION 2017
View Open Locked In 009135 Hamilton Construction Company 8/22/17 - 1/31/15
SR 504, WOOSTER CREEK CULVERT $2,095,588
REPLACEMENT CHRONIC ENVIRON.
DEFICIENCY
View End within & Open Locked In 009125 Rock Supremacy 6/30/17 - 4/2/18
mo. SR 503 MP 34.34 VIC, SPEELYAT SLIDE- $1,615,215
SLOPE - PHASE II
View End within 12 Open Locked In 009117 Hamilton Construction Company 7/6/17 - 6/30/18
mo. SR 432, Cowlitz River Bridge No 432/10S 4838,447
Repair and Overlay
View End within 3 Cpen Locked In 009116 MILL PLAIN ELECTRIC INC 6/23/17 - 1/31/16
mo. SR 503, ATIS INFILL - I/S BYPASS 4TH $523,312
PLAIN TO MAIN
View Open Locked In 0005456-1  American Civil Constructors West Coast 9/5/17 - 12/31/19
LLC $368,813
Curve Safety Improvemant
Viev Open Locked In 2021052-1  Jamesco Pro Inc 7/24/17 - 12/31/18
Oyler Road MP 3.24 Bridge Scour $301,966
View End within 12 Cpen Locked In €201004-1  SPECIALIZED PAVEMENT MARKING INC 8/8/17 - 9/30/18
mo. BZ Glenwood Highway High Friction Surface $160,755
Treatment
View Open Locked In 1602022-1  Pacific Contracting Resources, Inc. 7/31/17 - 12/31/15
Columbia Heights Road Slide Repair $143,680
Viev End within 3 Cpen Locked In 0005387-1  Petersen Brothers B8/15/17 - 12/31/17
mo. South Pekin Road Guardrail $52,688

To return to your dashboard, click on the *

ome’ button or the back browser arrow
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For the second way to access contracts, you will first need to set up your dashboard in DMCS. The following steps

will help guide you through the process:

The System Dashboard Refresh  Personalize ({))

7 WSDOT

- = Sh Welcome to your new Dashboard! Alerts
Mo Activated Alerts. View Pending Alerts.

Home This tool can be personalized and configured to display
exactly the information you want to see, in a simpler & Conf
View »» cleaner format. =
Search » Take advantage of many powerful features:
. System News
Reporting » + Control exacily what, where, and how to display
dam L1}
Create >» - Add multiple blocks of information NEW FEATURE -- "Saved Search
Tools » + Place a block on the left or right of the Parameters
ools Dashboard . A little bit of development magic to report -- you camn
. = + Set data based on your own assigned records or now save search parameters for future use. Run any
Settings the entire organization kind of search (vendor, certified vendor, contract, etc.)
= Move blocks up or down on the Dashboard and at the bottomn of the results page click the Save
Help & Support » + Change the color of a block to highlight important Search Parameters buttan, enter 2 descriptive
information reference name, and save. Every time you revisit the
Lﬂgﬂﬁ search page, there will be 2 Used Saved Search

o - Mew data opfions are added monthly button at the top that will list all saved searches
Show Al Hide Al available to you. #WishListDreamsDoComeTrue!

Click Personalize to get started.

A

Maota: this feature dees not save the search results, it
saves the search parameters. So using the saved
search in the future will rerun the search parametars
with then-current data. It saves the time of having te
manually enter multiple parameters for complex
searches.

Final Call - 2018 User Training - May
21-24

Click here for class list, agenda, more details,
and registration
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The System Dashboard
> wspor
= = [ &
Home
fiew » C IC ion S Y
buerts ] vLocation: | Lek caumn
contracts
jcontract Audits Contract Summary
Pub Rea [ vLocation: vef cobmn
Joutreach Campaigns
Fuents y
e Contract Audits
Froposals [ vLocation: Lef cobmn
Jitilization Plans
Fupport Priority Flagged Contracts
Pessages O )
Location: | Left column
pearch »
keporting » Contracts Awarded (Fiscal Year)
[reate » [ Location: | Left coumn
‘ools »
= Utilization Plans
ngs > [ vLocation: Lef cobmn
Help & Support »
| ogoff Qutreach
Show all Hide All [ Location: L cokumn
Favorite Reports
[] Location: L=k cobsmn
Help Desk
[ vLocation: Lef cobmn
#1 Add to Dashboard [ Cancsl ]

4[] Color: grey

4[v]| Color: grey

T grey

grey

T grey

T grey

grey

grey

T grey

Data:

Data:

Data:

Data:

Data:

Data:

Personalize your Dashboard by selecting one or more modules:

Check the checkbox for each module you would like to add to your Dashboard. Update the Data, Location, Position, and Color seftings as desired. Access to the records
and functions in each module are based on your user role. Click Add to Dashboard when finished

For User

For User

For User

For User

For User

For User

Refresh  Personalize ({§)
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Alerts

Total active 1 Mo Activated Alerts. View Pending Alerts.
Audited 1
View » Soon to end (2 mo) 1 Config
Search » Displaying User Data - Config
- System News
Reporting »
Payments % Goal __m
Create » Contracts S vale o et NEW FEATUrl'lE Saved Search
) Parameters
Tools > Mo records assigned
A little bit of devalopment magic to report — you can
- Displaying User Data - Config now save search parameters for future use. Run any
Sel:l]ngs B2 s Esrs = kind of search (vendor, certified vender, contract, ete.)
and at the bottom of the results page click the Save
HE'P B 9-||J|:“"'|: » Search Parameters button, enter 2 descriptive
Contract Audits Total < 80 days = 90 days reference name, and save. Every time you revisit the
Lognlf = search page, there will be a Used Saved Search
- Total Audits 3 2 E] button at the top that will list all saved searches
Show All Hide All Closeouts/ Final i i o available to you. #WishListDreamsDoComeTrus!
Disptaving User Dats - Conf Notfe: this feature dees not save the search results, it
pEvE = saves the search parameters. So using the saved
search in the future will rerun the search parameters
with then-current data. It saves the time of having to
manually enter multiple parameters for complex
searches.

*You now know how to access YOUR assigned contracts!

Contracts I
Total active
Home .
Audited
View » Soon to end (3 ma)
Search » Displaying User Data - Config
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S Help & Tools 3¢
-~ Transactions: Contracts -
v# WSDOT

~ Contracts | Contract Audits | Sub Requests | 1391 Reports Proposalsl Util Plans | Outreach | Supporil Messages |
=
i = & Show ONLY contracts assigned to you

Home 1 - 1 of 1 records displayed: Previous Page < Page 1 v | > Next Page Records per page 20
View »
To resort, click on column title. Rafrash Tabla
Search » Actions Alert Status  Secondary Status Contract Number Description  Prime End Date ¥ Amount
Reporting » All ~ | Open All e All All ~ All e
e A T — View Open Locked In 009142 Faber Construction 9/6/17 - 12/29/17
Corporation 4464,970
BURLINGTON PEO TENANT
»
Tools IMPROVEMENTS
Settings » WASHINGTON STAT
Help & Support »
9 Customer Support Home | Help | Print This Page | Print To PDF
Show All Hide All Copyright © 2018 B2Gnow. All rights reserved.

Please note: The Compliance Officer (project/local agency staff) and Secondary
Compliance Officer (OEO Staff), will be populated prior to your access to this

system.
6\'5“01' Contract Management Help & Tooks
M-]mlm@lsuwlmlcmmm-urmoms Alerts | Comments | Messages | Closeout
« = @0 @ Audit List | Audit Summary AudLFY | Reviews | Site Visits | Roports |
009142: BURLINGTON PEO TENANT Status: Open/Locked In
Home Frime; Faber Construction Corporation Current Award: $464,070
View 9/6/2017 - 12/29/2017 Gosl: 26.00%  Total Paid: $513,942
» % Credit: 6.95%  For Credit: 35,702
Search »

¥ Add to Dashbeard as Priority flagged Contract Refresh Page

Reporting » Contract Information
Create » ‘Contract Tilke BURLINGTON PEQ TENANT IMPROVEMENTS WASHINGTON STAT
Tools » Contract Number 009142
Prime Contractor Faber Construction Corporation
Settings » System Transaction Number 02216628-001
Help & Support » Awardistan Date 91812017
(Projected) End Date 1212812017
Logoff Contract Value $464,870.00

Contract Status & Actions

Status ACHONS. Detail
Conlracl Stalus Orcl“l View Contract. E4it Contract, Close Qut
(Locked In) Change Secondary S1amus 1o
Locked In w
> (= OMficer Assigned Change Compliance Officer to: Assigned o,
Olga Peterman
g Paterman o
Secondary Complance Officer Assigned Change Secondary Compliance Cfficer fo: ASSIGNea 1o
—) ) Allison Spector
Allison Spector v-
Compliance Manioring Automatically (Monthby)
BUBCONIrACIOrs. 2 subs Manage Subcontractors
Task Orders Create Tazk Order
Contract Change Orders Amend Contract. Change Yalue None:
Contract Extensions/Shortenings Extend/Shorien Contract None:
Other Functions Delete Contract. Vendor Archive Full Archive Copy Contract
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Contract Management

Help & Tools 3

A | View | Settings | Subs | Does | Change Orders & Task Orders | Alerts | Comments | Messages | Closeout
L = Cempliance Audit List | Compliance Audit Summary | Compliance Audit FY | Reviews | Site Visits | Reporis |
009098: PLAYGROUND. US 97 /SR 14, PAVING - KLICKITAT COUNTY Status: Open/Locked|
s Prime: Test Prime Vendor 24 Current Award: $4,600,5)
5/22/2017 - 6/30/2018 Goal: 6.00%%0 Total Paid: 2,098, 1
ey > %% Credit: 0.00%0 For Credit:
erts .
B '|'-_. Add to Dashboard as Priority Flagged Contract Refrash
ontract Audits Contract Information
b Requests Contract Title PLAYGROUND. US 97/SR 14, PAVING - KLICKITAT COUNTY
utreach Campaigns Contract Number 009098
prents Prime Contractor Test Prime Vendor 24
endor Lists v Ti 02108688-001
[oposals Award/Start Date 5/22/2017
julization Plans {Projected) End Date 6/30/2018
upport Coniract Value $4,600,520.00
parch > Contract Status & Actions
Eporting > Status Actions Detail
Contract Status Open » View Contract, Edit Contract, Close Out
e {Locked In) * .
Change Secondary Status to:
b
pols Locked In
Sl E i : : N
prtings Compliance Officer Assigned Change Compliance Officer to- 3?9@"1}2‘:;0-
ga rman
RIp & Support » Olga Peterman
bgoff Secondary Compliance Officer Assigned Change Secondary Compliance Officer to: Assigned to:
bow an Hida All Jacki Doty ~ Jacki Doty
Compliance Monitoring Automatically
(Monthly)

Contract: View

12

Help & Tools 3¢

Docs | Change Orders & Task Orders | Alerts | Comments I Messages. { Closeout ‘
ce Audit List | Compliance Audit Summary ‘ Compliance Audit FY | Reviews | Site Visits ‘ Reports l

Status: Open/Locked In
Current Award: $464,970
Total Paid: $513,942
For Credit:  $35,702

009142: BURLINGTON PEO TENANT IMPROVEMENTS WASHINGTON STAT
Prime: Faber Construction Corporation

9/6/2017 - 12/29/2017 Goal: 26.00%

% Credit: 6.95%

This is a detailed listing of the Contract

Contract Information

Contract Title BURLINGTON PEO TENANT IMPROVEMENTS WASHINGTON STAT
Contract Number 009142

System Transaction Number 02216629-001

Contract Holder/Owner Washington State Department of Transportation

Depariment State Highways and Marine Terminals

Current Contract Value $464,970.00

Original Contract Value $464,970.00

Contract Value Change $0.00

Contract Secondary Status Locked In

Federal Aid Number

Commitment Value 0

Contract Dates

Award/Start Date a/6/2017 (Projected) End Date 12/29/2017

Prime Contractor Information
Business Name

Faber Construction Corporation

System Vendor Number 20340871

Compliance Contact Person Kim Bunker

Phone 360-354-3500

Fax 360-354-0355

Email kim@faberconstruction.com
Address 131 E Grover St.

Lynden, WA 98264

EMAIL QUESTIONS TO: DiversityReporting@wsdot.wa.gov
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5_ Contract Management: Subcontractor List Help & Tools *‘
7 WSDOT
Main | View | Settngs | Subs | Docs | Ghange Orders & Task Orders | Alerts | Comments | Messages | Gloseout
& = [@] & Complance AudiList | Compliance Audit Summary | Compliance Audit FY | me-s| Site Visits | Reports
Home 009142: BURLINGTON PEOQ TENANT IMPROVEMENTS WASHINGTON STAT Status: Open/Locked In
Prime: Faber Construction Corporation Current Award: $464,970
9/6/2017 - 12/29/3017 Goal: 26.00% Total Paid: $513,942
View » % Credit: 6.95%  For Credit: $35,702
Search »
Reporting » Add Subcontractor
Create »
Prime Contractor
Tools » —
Compliance
., Vendor Name Certified Inc. in Goal Audit Final Pmint Actions
E Faber Construction Corporation No Mo e No View Edit Maore....
Help & Support »
9 Subcontractor Award Totals
Show Al Hide All
Original Subs Towards Goal With  Current Subs Towards Goal With
Current Contract Goal All Subs Deductions Deductions Subs Towards Goal
Amounts $120,892.20 $26,270,00 $0.00 $17,870.00 $17,870.00
“Pﬂﬂllgﬂ 26.000% 5.650% 0.000% 3.843% 3.843%
Subcontractors
Subcontractor Name Certified o, 0 Original rype I&T “’I;'.'&‘.’:"“ ;;m"::: Actions
E Bouwman Masanry & Stucco (19873.009) Mo 2R,400 Sub Mo .Q Mo View Fdit Mare... <
58,400
El ENVIRONMENTAL ABATEMENT SERVICES TNC (19873.001) [~] 417,870  Sub ® ® Mo View Fdit More
$17,870 100%  wpg

Subcontractor Award Totals

Current Contract Goal All Subs Original Subs Towgrds Goal With  Current Subs Towards Goal With Subs Towards Goal
Deductions Deductions
Amounts $120,892.20 $26,270.00 $0.00 $17,870.00 $17,870.00
Percentages 26.000% 5.650% 0.000% 3.843% 3.843%
Subcontractors
. Original Inc.in Compliance Final .
Subcontractor Name Certified Cu t Type Goal Audit Pmnt Actions
m Bouwman Masonry & Stucco (19873.009) No $8,400 Sub No @ No View Edit More...
$8,400
E ENVIRONMENTAL ABATEMENT SERVICES INC (19873.001) @ $17,870 Sub @ @ No View Edit More...
$17,870 100%  mpE

Print All Sub Letters } [ Print All Letters } [ Message All Subs ] { Message All } [ Outreach All

{ Validate Work Codes J

I Create Cert Tracking Log Records For All Contractors J

*In the above screenshot, you can tell that Environmental Abatement Services, Inc. is a state certified MBE based on

the symbol in the ‘Include in Goal’ column. Below are some examples of symbols you will see in the system:

@ © © ©

DBE MBE SSBE WBE
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Contract Management: View Subcontractor Help & Tools ¢

Mazin | View | Settings | Subs | Docs | Change Orders & Task Orders | Alerts | Comments | Messages | Clnseuut|
Compliance Audit List | Compliance Audit Summary | Compliance AuditFY] Reviews] Site VisHs] Reporis.

009142: BURLINGTON PECQ TENANT IMPROVEMENTS WASHINGTOM STAT Status: Open/Locked In
Prim=: Faber Construction Corporation Current Award: $464,970
9/6/2017 - 12/29/2017 Goal: 26.00% Totzl Paid: $513,042

% Credit: 6.95%0 For Credit: $35,702

Return |
Vendor Information

Business Name Bouwman Masonry & Stucco
System Vendor Number 20438926
Vendor Compliance Contact Person Kent Bouwman
Phone 360-354-3811
Fax
Ernail bouwmanmasonryi@aol.com
Address 1659 Main Street
Lynden, WA 98264

Applicable Vendor Certifications

Mo applicable certificafions.

Contract Information

Vendor Type Subcontractor
Subcontractor Tier Tier 1 subcontractor to Faber Construction Corporation
Reference ldentifier 19873.009
Contracted Percent & Amount Current  Original Award Change/Adjustment
Amount: $8,400.00 $8,400.00 50.00
Percent: 1.807% 1.807% 0.000%
Type of Participation Subcontractor/Subconsultant
- Original verification amount: $8,400.00
Include im Compliance Audits? Yes - subcontractor ig active and should be included in the periodic compliance audits of the contract.
Count Towards Certified Goal No
Final Payment Made No
Starting Paid To Dafe Amount $8,400.00 as of 10/31/2017
Final Amount Adjustment $0.00
Subcontract Award Date 1001772017
‘Work Start Date 10/2002017
Work End Date 1003172017
Work Descripfion EFIS Repair
Work Codes NAICS 235140 Masonry Contractors {More)
Unigue Identifier
Comments Project Complete. Vendor Paid.
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*
Contract Management: Subcontractor List Help & Tools

-
WWSDOT "

Main | View | Somnns] Subs | Docs | Change Orders & Task Orders | Merts | Comments | MESSa005 | Closeout
& = [] &  Complance AuditList | Compliance Audit Summary | Compliance Audit FY | Rsuiewsl Sile Visits | Reports

Home 009142: BURLINGTON PEO TENANT IMPROVEMENTS WASHINGTON STAT Status: Open/Locked In
Frime: Faber Construction Corporation Current Award: $464,970
962017 - 12/29/3017 Goal: 26.00% Total Paid: $513,942
View » % Credit: 6.95%  ForCredit: $35,702
Search »
Reporting » Add Subcontractor
Create »
Prime Contractor
Tools »  Prime Contrctor |
E— Certified Inc. in Goal “";ﬁ:"“ Final Pmnt Actions
E] Faber Constru No No e Ne Wiew Edlit More....
Help & Support »
9 Subcontractor Award Totals
Showe all Hide all S -
Current Contract Goal Al Subs Original Sugedw_arﬂs Goal With  Current Sulb}:"l'ow:vus Goal With Subs Towards Goal
Amounts £120,892.20 £26,270.00 S0.00 $17,870.00 $17,870.00
Percentages 26.000% 5.650% 0.000% 3.843% 3.843%
Subcontractors
. DOriginal Inc. in Compliance  Final .
Subcontractor Name Certified Current TYPE  Goal Audit Pmnt Actions
E] Bouwman Masonry & Stucco (19673.009) No $6,400  Sub No F No  View Edit Mo
58,4
E ENVIRONMENTAL ABATEMENT SERVICES TNC (19873.001) @ $17,870 Sub @ Q No i @.
S17,870 100%  mpp

aEL. e U wiTuL g us

-
7 WSDOT

T 0 Ea & ¥ regquired entry

w Vendor Information

Lo [vendor - | environmenTAL ABATEMENT SERVICES NG
View » Vendor Compliance Contact * CATHERINE D MARQUEZ ~
Search » Contact not list=d? QuickAdd = new compliance contact.
Reporting » Eendoiuciessh PO BOX 2503, Mount Vernon, WA 98273
Create » Address not listed? QuickAdd a new address.
Tools »
., Applicable Vendor Certifications
Settings »
Type Effective Renewal Organization
Help & Support » MWBE 211712015 2/17/2018  Washington State Office of Minority & Women's Business Enterprises
Logoff State of
SBE Mot available Washington
Show Al Hide Al DES
DBE 201772012 2017/2013 i State Office of Minorily & Women's Busi ; i
Subcontract Information
Subcontractor Tier * Subcontracts to| [Prime] Faber Construction Corparation v
Reference Identifier 19873.001
Contracted Percent & A t* Current Original Award
® By Amount 3 17.870.00 s 17.870.00

O By Percent | 3.84325870 % 3.84325870 %

Enter the full amountypercent of the subcontract or the percent relative to the total contract value ($464,570). Do not
deduct amount/percent of subcontracts awarded by this subcontractar,

Type of Participati Subcontractor/Subconsultant ~

\ 4

Percent of payments to be counted: | 100.00 %

Amount not to be included in award verification: § 0.00

5 17870 as of 10/34/2017
Starting Paid To Date Amount Enter the full starting amount paid to this subcontractor. Do not deduct starting amounts paid to lower tier
subontractors.

Final Amount Adjustment/Paid Retainage 20

Note:

Date Paid: (mmydd/yyyy)
Entar tha full final ameunt paid to this subcontractor. Do not deduct finzl amounts paid to lower tier subontractors.

Logged on as:
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Outreach Campaigns Subcontract Information
Subcontractor Tier * Prime] Test Prime Vendor 24
e s ubcontractor Tier Subcontracts to| [Prime] Test Prime Vendor
Proposals Reference Identifier
Utilization Plans
Support Contracted Percent & Amount * Current Original Award
Messages (®) By Amount: § 104.000.00 $ 104.000.00
Search » O By Percent | 226061402 % 226061402 %
Reporting » Enter the full amount/percent of the subcontract or the percent relative to the total contract value ($4,600,520).
Create » Do not deduct amount/percent of subcontracts awarded by this subcontractor.
icipati 4 e
Tools » TES E (T ractor/Subconsultant
Supplier - Manufacturer
Settings » Supplier - Regular Dealer
Supplier - Packager, Broker, Distrib.. Wholesaler, Manuf. Rep.
Help & Support » Joint Venture
Fees & Commission Broker
Log 3 _ ruckin aulin
ot Starting Paid To Date Amount Trucking & Hauling
Show All Hide All 9 Trucking & Hauling Brokerage amounts paid to lower tier
Self-Performing Prime Contractor
Final Amount Adjustment/Paid Retainage s0
Mote:
Date Paid: (mm/dd/yyyy)
Enter the full final amount paid to this subcontractor. Do not deduct final amounts paid to lower tier
subontractors.
Include in Compliance Audits? * @ “es - subcontractor is active and should be included in the periodi iance audits of the contract.
() Mo - subcontractoer is inactive.
Count Towards Certified Goal * This setfing is used only to set the default sfatus on future compliance audits and the starting/final amount fields below. To change the
status of all or specific existing payments, access the payment history for the contractor.
- ez - Payments fo this contractor count towards the selected goal (field below).
() No
Goal Type | MBE ~ | Credit Type: Not Selected R
| Fiia T Fayimenl made Ty ves
(@) Mo
Subcontract Award Date | 919/2017 (mmy/dd/yyyy)
Work Start Date 9/22/2017 (mmy/dd/yyyy)
Work End Date 10j20/2017 | (mmd/ddfyyyy)
Work Description Abatement
Work Codes Currently assigned work codes:
D> @ MAICS 541620 Envi tal consulting services (Remove)
Add Work Codes
Click here to see if there are any available work codes igned to gnized certificati for the igned vendor.
Unique Identifier
This identifier is used to match subcontractor import information to the correct record. Edit the field only if specifically instructed to.
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|Work Description Abatement

Work Codes Gurrently assigned work codes:
(@ NAICS 541620

“ Add Work Codes

tal ing services (Remove)

m

Click here to see if there are any available work cedes assigned fo recognized certifications for the assigned vendor.

Commodity Codes: Search Help & Tools ¢

Click any Add link to select a code. You can also search again, sort the list, or click Browse Codes to browse through the entire code list. If multiple code
lists are available, you can change the selected list in the drop down list under the search box. When finished, click Return to return to the record.

—p | traffic control [ Browse Codes ] [ Return ]

NAICS: North American Industry Classification System

1 - 7 of 7 records displayed
To sort, click column title.

Actions Code Type Code Code Description
Add NAICS 334511 Air traffic control radar systems and equipment manufacturing (More) [Size standard: 1250 employees]
Add NAICS 488111 Air Traffic Control (More) [Size standard: $22,500,000 annual revenues]
Add NAICS 488111 Air traffic control services (except military) (More) [Size standard: $32,500,000 annual revenues]
Add NAICS 561990 Flagging (i.e., traffic control} services (More) [Size standard: $11,000,000 annual revenues]
Add NAICS 611519 Air traffic control schools (More) [Size standard: $15,000,000 annual revenues]
Add NAICS 926120 Federal Aviation Administration (except air traffic control) (More)
Add NAICS 928110 Aijr traffic control, military (More)

*This above step is necessary ONLY if you think the NAICS codes assigned are incorrect.
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Now that you know how to login and access your assigned contracts, we will show the monitoring and verification
process!

Transactions: Contracts Help & Tools

Contracts | Contract Audits | Sub Requests | 1391 Reports | Proposals | Util Plans | Qutreach | Supporl| Messages

Show ONLY contracts assigned to you

1 -1 of 1 records displayed: Previous Page < Page | 1 ' > Next Page Records per page 20 v
To resort, click on column title. Refresh Table
Actions Alert Status Secondary Status Contract Number Description Prime End Date ¥ Amount
All ~ || Open ~ | | All ~ Al Al ~ All ~
P View Open Locked In 009142 Faber Construction Corporation 9/6/17 - 12/29/17
BURLINGTON PEO TEMANT $464,970
IMPROVEMENTS WASHINGTOM STAT

Contract Management Help & Tools

“ﬂi"l View I Seuingsl Suhs] Docsl Change Orders & Task Orders ‘ Alerts. | Comments l Messages [ Closeout ‘
P Compliance Audit List [ Compliance Audit Summary [ Compliance Audit FY [ Reviews [ Site Visits [- Reports

009142: BURLINGTON PEO TENANT IMPROVEMENTS WASHINGTON STAT Status: Open/Locked In
Prime: Faber Construction Corporation Current Award: $464,970
9/6/2017 - 12/29/2017 Goal: 26.00% Total Paid: $513,942

% Credit: 6.95% For Credit: $35,702

1'- Add to Dashboard as Priority Flagged Contract Refresh Page

Contract Information

Contract Title BURLINGTON PEO TENANT IMPROVEMENTS WASHINGTON STAT

Contract Number 009142

Prime Contracior Faber Construction Corporation

System Transaction Number 02216629-001

Award/Start Date 9/6/2017

(Projected) End Date 1212912017

Contract Value $464,970.00

Status Actions Detail
Contract Status Open View Contract, Edit Contract, Close Out
(Locked In)

Change Secondary Status to:
Locked In ~

Compliance Officer Assigned Change Compliance Officer to: Assigned to:
Olga Peterman
Olga Peterman v
Secondary Compliance Officer Assigned Change Secondary Compliance Officer to: Assigned to:
Allison Spector
Allison Spector %
Compliance Monitoring Automatically
(Monthly)
Subcontractors 2 subs Manage Subcontractors.
Task Orders Create Task Order
Contract Change Orders Amend Contract, Change Value None
Contract Extensions/Shortenings Extend/Shorten Contract None
Other Functions Delete Contract, Vendor Archive, Full Archive,
com/FrontPage/DiversityFrontPage asp?XID=4834 Copy Contract
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Click prime name to view payment history for this contract. Click contact person’s name to send them a message.

& 5 & Subcontractor
Advanced Traffic Control LLC [Info]
Home m Darrin Tish
Vi e DTish@AdvancedTrafficControl.net
5 P 425-495-1079
Alerts G & G Incorporated [Info]
GRAHAM BONNIE
Contracts e r——
. GGINC1992@A0L.COM
Contract Audits P 425-432-8125, F 425-432-8155
Sub Requests m Great Western Transport Inc [Info]
1391 Reports S.ileena Lavmance
- sileena.gwt@outlook.com
Outreach Campaigns P 425-754-7645, F 360-863-1888
Events INTERWEST CONSTRUCTION INC [Info]
Vendor Lists Contact Person
P 306-757-7574
Proposals
- Jonnic Construction, LLC [Info]
Utilization Plans Ken Wood
Support kennv@jonnicconstruction.net
Messages P 503-829-4123, F 503-829-6900
North Hi lesources [Info]
Search » Marissa Vetch
g mari interwest.biz
UENdor P 360-757-1866, F 360-707-2460
Certified Vendors 0O'Bunco Engineering Int'l, Inc. [Info]
Users Dee Williams
dwilliams@obuncoengineering.com
C"m:? ) P 425-451-7300
e e o m Reece Construction Company [Info]
Proposals Sasha Conner
Search Results » sasha@reece-construction.com
Vendo P 360-659-9600
ncors SPECIALIZED PAVEMENT MARKING INC [Info]
Users CANDICE TAVERNIER
Contracts candice@spmnw.com

Qutreach Campaigns
Proposals

P 503-885-0420, F 503-582-8629

Springbrook Nursery & Trucking, Inc. [Info]
Vickie Baldwin

Cert Type
Sub
@ 100%
@ Sub
100%
Mo Sub
No Sub
Mo Sub
No Sub
@ Sub
100%
Sub
@ 100%
No Sub
Mo Truck/Haul

Inc. in Goal for

Period This Period Confirmed By
[c] $107,688.50 Confirmec
DBE View Edit View Edit

Prompt: Yes Prompt: Ye
€] $18,758.50 Confirmec
DBE View Edit View Edit

Prompt: Yes Prompt: Ye

Partial
No $9,888.35 Not Yet
View Edit View Edit

Prompt: Yes  Resend Noti

No $0.00 Confirmec
View Edit View Edit

No $50,189.53 Not Yet
View Edit View Edit

Prompt: Yes  Resend Notii
No $675.00 Confirmec

View Edit View Edit

Prompt: Yes Prompt: Ye
[c] $13,110.95 Confirmec
DBE View Edit View Edit

Prompt: Yes Prompt: Ye
] $33,102.61 Confirmec
DBE View Edit View Edit

Prompt: Yes Prompt: Ye

Partial
No $7,695.00 Confirmec
View Edit View Edit

Prompt: Yes Prompt: Ye

No $9,737.50 Confirmec
View Edit View Edit
Prompt: Yes Prompt: N/

19

Reporting » springbrooknursery@hotmail.com
P 360-653-6545
Create » Click subcontractor name to view payment history for this contract. Click contact gerson's name to send them a message,
Tools »
Settings »

Help & Support »

1 | Resend Reporting Notices to All Unresponsive Subs ]

[ Reset Zero Responses

Thank you for your time, if you have additional questions, please email

EMAIL QUESTIONS TO: DiversityReporting@wsdot.wa.gov
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Appendix

Appendix A: Example of Payment Difference Between Contract Amount and Prime Payments

The below screen shot shows an example of when the contract amount differs from the payment made to the prime.

Flag This Compliance Audit Refresh

Compliance Audit Information

Compliance Audit Time Period October 2017

Compliance Audit Status None selected ~ | Update

Compliance Audit Reference Add Reference

System Audit Number 02151791-0007

Date Posted Local: 11/1/2017 4:09:29 AM PDT

System: 11/1/2017 6:09:29 AM CDT

Final Audit? No (mark audit as final)

Payment to Prime $578,734.45 on 10/16/2017 - Edit & View Details

| Add Comment |

| << View September 2017 Audit << | | => View November 2017 Audit >> |

Compliance Audit Summary - October 2017 and Totals To October 2017

October 2017 Totals to October 2017
Payments Percent Payments Percent

Contract Award Value & Goal I $1,615,219.00 Goal:
10.000%

Paid to Prime $578,734.45 $654,038.80

For Credit Payments $0.00 0.000% $0.00 0.000%

For Credit to DBE Goal $0.00 0.000% $0.00 0.000%

For Credit to FSBE Goal $0.00 0.000% $0.00 0.000%

For Credit to MBE Goal $0.00 0.000% $0.00 0.000%

For Credit to SSBE Goal $0.00 0.000% $0.00 0.000%

For Credit to VBE Goal $0.00 0.000% $0.00 0.000%

For Credit to WBE Goal $0.00 0.000% $0.00 0.000%

Subcontractors - October 2017

Total
Confirmed Payments Contracted Actual
By Sub to October Percent Percent
2017

0.00 Confirmed £0.00 1.457% 0.000%
dit  View Edit

Inc. in Goal

e This Period

Subcontractor Cert Type

w

C&R Tractor & Landscape, Inc. [Info] (v] Sub No
Casev Heaton SSBE View Edit
casey@candrtractor.com

Columbia Pacific Construction, Inc [Info] No Sub No Not included in audit $0.00 1.114% 0.000%
Linda Johnson Add to audit
linda@cpenw.com
P 360-225-6323

Columbia River Contractors, inc. [Info] No Sub No $0.00 Confirmed £0.00 0.706% 0.000%
Charles Parks View Edit  View Edit
charlesp@colriveontr.com
P 503-722-1777, F 503-722-1778

E] Drain Pro, Inc [Info] No Sub No Not included in audit $0.00 0.176% 0.000%
Kelly Schueler Add to audit
kelly@drain-proinc.com
P 253-926-5586

Explosives Services Inc. [Info] No Sub No %$2,746.00 Confirmed $21,549.00| 8.668% 3.290%
Greg Rogers View Edit  View Edit
grogers@blackfoot.net Prompt: Yes Prompt: Yes
P 406-777-1737, F 406-777-1937

E] Precision Paving Plus L1 C [Info] (V] Sub No Not included in audit £0.00 1.413% 0.000%
Angie Sullivan SSBE Add to audit
angie@ppavingplus.com
E] SPECIALIZED PAVEMENT MARKING INC [Info] No Sub Mo $0.00 Confirmed $0.00 0.396% 0.000%
MARK PRICE View Edit  View Edit
MARK@SPMNW.COM
F 503-885-8960

West Coast Soil Solutions [Info] Mo Sub No Not included in audit $0.00 0.421% 0.000%
Doug O'Neal Add to audit
doug@westcoastsoilsolutions. com
P 360-521-2613, F 360-666-0255

Click subcontractor name to view payment history for this contract. Click contact person's name to send them a message.

=
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Appendix B: Exiting System Without Logging Out

You will see this screen if you leave the system without logging off:

A session for your account is currently active. This may be due to an active session on
another computer or a previous session not logged off.

You can assume the active session on this computer, terminate the other session (all
unsaved information will be lost) or return to the login page.

| Assume Existing Session on This Computer ‘

| Continue Login & Terminate Other Session |

| Return to Login Page
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Appendix C: Finding a Payment Made to the Prime

Transactions: Contracts FET0oN
Contracts | Contract Audits | Sub Requests | 1391 Reports | Proposals | Util Plans | Outreach | Support | Messages
e o= =) ["] Show ONLY contracts assigned to you
Home 21 - 40 of 306 records displayed: Previous Page < Page 2 * = Next Page Records per page 20
Next Page
View »

: To resort, click on column title. Refresh Table
Bz Actions Alert Status Secondary Status Contract Number Description Prime End Date ¥ Amount
Contracts
Contract Audits All ~ | Open ~ All N Al ~ Al All v
Sub Requests View  End within 12 mo. Open Locked In 009222 Lakeside Industries Inc. 3/28/18 - 6/28/19
1301 I-5, E FORK LEWIS RIVER BR TO WEIGH STATION $10,015,451

I . VIC PAVING/BR. DECK REPAIR

Outreach Campaigns View End within 12 mo. Open Locked In Lakeside Industries Inc. 2/7/18 - 4/25/19
Events US 2, I-5 I/C TO BICKFORD AVE VIC PAVING $9,542,991
vendor Lists VMiew  End within 12 mo. Open Locked In MidMountain Contractors, Inc. 4/12/18 - 6/6/12
I-5, 5B 5 LUCILE 5T TO SPRING ST - PAVEMENT $8,989,475

Proposals REPAIR
\tilizatipn Plans Open Locked In CENTRAL WASHINGTON ASPHALT INC 3/28/18 - B/14/19
Support SR 21 ET AL, 2018 EASTERN REGION CHIP SEAL $8,887,511
Messa v Open Locked In 5552001-1 RAM Construction General Contractors, LLC 10/9/17 - 12/31/20
ges Granary Avenue & Laurel Street $8,710,0938
Search » View Open Locked In 0931017-1 Thomco Construction, Inc. 5/14/18 - 12/31/22
= 36th Avenue W Roadway Improvement 48,668,842

endors View Open Locked In 2575003-1  Marshbank Construction, Inc. 4/4/18 - 12/31/22
Certified Vendors 35th Ave SE, 180th St SE to 152nd St SE, Phase £8,650,007
Users L
Contracts Wiew Open Locked In Acme Concrete Paving Inc. 5/14/18 - 12/11/19

. US 395, NSC - COLUMBIA TO FREYA $8,217,203
Outreach Campaigns VMiew  End within 12 mo. Open Locked In Granite Construction Company 1/22/18 - 5/25/19
Proposals SR 9 ET AL, MT BAKER AREA BST - 2018 £7,6804,005
Search Results » View Open Locked In Tapani Underground, Inc. 12/22/17 - 12/30/19
SR20, SHARPES CORMNER VICINITY $7,224,164

Reporting » IMPROVEMENTS MP 47.0

7 WSDOT

Contract Management

22

e o=
Home
View »

Alerts

Contracts

Compliance Audit List \ Co

5552001-1: Granary Avenue & Laurel Street
Prime: RAM Construction General Contractors, LLC

10/9/2017 - 12/31/2020

Docs | Change Orders & Task Orders ‘ Alerts | Comments | Messages | Closeout |
pliance Audit Summary | Cempliance Audit FY | Reviews | Site Visits. | Reports ‘

Help & Tools 3%

Status: Open/Locked In
Current Award: %$8,710,938

Goal: 16.1206
% Credit: 20.53%

Tl Add to Dashbeard as Priority Flagged Contract

Total Paid: $5,611,392
For Credit: $1,151,833

Refresh Page

Contract Audits
Sub Requests
1391 Reports
Qutreach Campaigns
Events
Vendor Lists
Proposals
Utilization Plans
Support
Messages

Search »
Vendors
Certified Vendors
Usars
Contracts
Qutreach Campaigns
Proposals
Search Results »

Contract Information

Contract Title Granary Avenue & Laurel Street
Contract Number 5552001-1
Prime Contractor RAM Construction General Contractors, LLC
Sysiem Transaction Number 02256645-0001
Award/Start Date 10/9/2017
(Projected) End Date 12131/2020
Conlract Value $8,710,938.09
Contract Status & Actions
Status Actions Detail
Contract Status Cpen View Contract. Edit Contract, Close Out
(Locked In) -
Change Secondary Status to:
Locked In ~
Compliance Officer Assigned Change Compliance Officer to: Assigned to
Evan Nnambi
Evan Nnambi e
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7 WSDOT
- = S

Home

View »

Alerts

Contracts

Contract Audits

Sub Requests

1291 Reports
Outreach Campaigns
Events

Vendor Lists

Contract Management: Subcontractor List

Vendor Name

E] RAM Construction General Contractors, LLC

Main | Vlew| Settings ‘ S“bﬁl Docs | Change Orders & Task Orders| Alerts | Comments | Messages | Closeout |
Compliance Audit List | Compliance Audit Summary | Compliance Audit FY | Reviews | Site Visits | Reports |

5552001-1: Granary Avenue & Laurel Street
Prime: RAM Construction General Contractors, LLC
10/9/2017 - 12/31/2020

Add Subcontractor

Prime Contractor

Status: Open/Locked In
Current Award: $8,710,938
Total Paid: $5,611,392

For Credit: $1,151,833

Goal: 16.12%
% Credit: 20.53%

Certified Inc. in Goal Comﬂlé?tnoe Final Pmnt
Mo No (7] No View Edit More..)

Award Letter

=

Utilization Plans

Help & Tools 3%

Info Letter
View Profile /
g

Support
Messages
Subcontractor Award Totals
Scarch » | subcontractor Award Totals |
Vendors Current Contract Goal All Subs Ong'”ﬂiiugigﬁgiif; Goal Curre%i”?;}s;:ﬁ::; Goal Subs Towards Goal
Certified Vendors Amounts $1,403,809.00 $4,532,653.41 $1,403,809.00 $1,450,484.00 $1,450,484.00
Users Percentages 16.115% 52.034% 16.115% 16.651% 16.651%
Contracts

7 WSDOT

& =

Home
View »
Alerts
Contracts
Contract Audits
Sub Requests
1391 Reports
Qutreach Campaigns
Events
Vendor Lists
Proposals
utilization Plans
Support
Messages
Search »
Vendors
Certified Vendors
Users
Contracts
Qutreach Campaigns
Proposals
Search Results »

Create »

Tools »

Settings »

Help & Support »

1 nnnff
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Contract Management: Payment History for Prime Contractor

Help & Tools x

Main ‘ Vew| Settings | Subs‘ Docs | Change Orders & Task Orders ‘ Alerts ‘ Comments | Messages ‘ C\useoul|
Compliance Audit List ‘ Compliance Audit Summary ‘ Compliance Audit FY I Reviews | Site Visits I Reports I

5552001-1: Granary Avenue & Lilurd Street
Prime: RAM Ci

10/9/2017 - 12[31/202[!

Contractor Information

Status: Open/Locked In

LLC

Goal: 16.12%

% Credit: 20.53% For Credit: $1,151,833

Contract Payment Summary

Bellingham, WA 98226

Business Name RAM Construction General Contractors, LLC Contract Value $8,710,938.09

Vendor Type Prime Contractor Total Payments to Prime $5,611,391.95

System Vendor 20508358 Amount Retained by Prime* $2,726,780.13 48.594%
Number * Lower tier subcontract awards and payments are subtracted to give the
ender Contact Kat Koncz “retained” value.

Phone 360-715-8643

Fax 360-715-0203

Email kat@ramconstruction-wa.com

Address 4290 Pacific Highway

Contract Payment Details

Time Period Amount Paid EE Actions
Starting Amount as of 9/30/2017 $0.00 No (change) Edit
October 2017 $0.00 No (chanage) Edit
November 2017 $0.00 No (change) Edit
rRacamhar 04T, £295,202.22 hlauteh Sai
January 2018 $657,901.46 No (change) Edit
M $1,645,444.47 NG (chanae) Eait
March 2018 $0.00 No (change) Edit
April 2018 $790,341.77 No (change) Edit
May 2018 $971,932.01 No (chanae) Edit
June 2018 $1,159,878.98 MNo (change) Edit
Final Amount Adjustment/Paid Retainage $0.00 No (change) Edit
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7 WSDOT

Home

View »

Vaerts

Contracts

Contract Audits

Sub Requests

1391 Reports
Outreach Campaigns
Evenis

:::-:5

Help & Tools

Compliance Audit: Audit Summary for January 2018

Main ‘ View | Settings | Subs ‘ Docs | Change Orders & Task Orders | Alerts ‘ Comments | Messages ‘ Closeout ‘
Compliance Audit List | Compliance Audit Summary | Compliance Audit FY | Reviews | Site Visits ‘ Reports |

Status: Open/Locked In
Current Award: $8,710,938
Total Pai 5,611,392

For Credit: $1,151,833

5552001-1: Granary Avenue & Laurel Street
Prime: RAM Construction General Contractors, LLC
10/9/2017 - 12/31/2020 Goal: 16.12%

% Credit: 20.53%

¥ Flag This Compliance Audit Refresh

Compliance Audit Inform
Compliance Audit Time Period
Compliance Audit Status

January 2018
None selected ~  Update

Compliance Audit Reference Add Reference

Wendor Lists
Proposals System Audit Number 02256645-0018
Utilization Plans Date Posted Local: 2/1/2018 4:04:38 AM PST
System: 2/1/2018 6:04:38 AM CST
Support Simal A Momaslsouditasfinal)
Messages N | =
| Payment to Prime $657,801.46 on 1/22/2018 - Edit & View Details I
Search »
Ve Add Comment
Certified Vendors
Users
Contracts [ << View December 2017 Audit << l l >> View February 2018 Audit >> l
Outreach Campaigns
Proposals Compliance Audit Summary - January 2018 and Totals To January 2018
Search Results » January 2018 Totals to January 2018
Rgponjng » Payments Percent Payments Percent
Contract Award Value & Goal $8,710,938.09 Goal: 16.115%
Create » Pald to Prime $657,901.46 $1,043,794.78
Tools »
For Credit Payments $96,705.67 0.000% $128,136.37 0.000%
Settings »
Help & Sup » For Cred!t to DBE Goal $96,705.67 14.699% $128,136.37 12.276%
For Credit te FSBE Goal 50.00 0.000% $0.00 0.000%
Logoff For Credit to MBE Goal $0.00 0.000% $0.00 0.000%
Shaw Al wide Al For Credit to SSBE Goal $0.00 0.000% $0.00 0.000%
Washington State For Cradit to VBE Goal $0.00 0.000% $0.00 0.000%
Department of For Credit to WBE Goal $0.00 0.000% $0.00 0.000%
Transportation
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Appendix D: Glossary of Frequently Used Terms

DMCS = Diversity Management and Compliance System = B2GNow

Work Code = Commodity Code = NAICS Code or North American Industrial Classification
System Code

Audit = Payment

Vendor = Contractor(s)
Compliance Officer = WSDOT
Audit Period = Reporting Month

Power User = Person assigned contracts

25 EMAIL QUESTIONS TO: DiversityReporting@wsdot.wa.gov
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